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บทท่ี 1 ท ำควำมรู้จกั Tableau 
 

Tableau เป็นซอฟต์แวร์ที่สามารถน าข้อมูลจ านวนมากที่มีหลากหลายในองค์กรมาท าการวิเคราะห์
เพ่ือเป็นข้อมูลเชิงธุรกิจช่วยให้ผู้บริหารมีข้อมูลเชิงลึกเพ่ิมความสามารถในการตัดสินใจอย่างรวดเร็วและชาญ
ฉลาด ในรูปแบบของ Data Visualization ซึ่งเป็นการใช้ภาพเพ่ือแสดงข้อมูลในเชิงปริมาณที่วัดได้ ไม่ว่าจะ
เป็นตัวเลข แผนภูมิ กราฟ และอ่ืน ๆ อีกมากมาย  ค าว่า Data คือ ข้อมูล ส่วน Visualization คือ การมองเห็น 
เมื่อน ามารวมกันแล้วหมายถึง ข้อมูลที่มองเห็นได้ด้วยตา  

 

 
 
 
 

แหล่งที่มา : http://tableauthailand.blogspot.com/2016/10/ 
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คุณสมบติัและจุดเด่นของซอฟตแ์วร์ 

คุณสมบัติที่โดดเด่นอย่างเห็นได้ชัด คือ  
 ผู้ใช้มีเครื่องมือที่ใช้วิเคราะห์ข้อมูลได้หลากหลายมิติ ไม่ว่าจะเป็น รูปแบบของ Online 

Processing เป็นต้น   
 รูปแบบการใช้งานที่ง่ายเพียงคลิ๊กเมาส์ก็สามารถที่จะเปลี่ยนแปลงรายงานได้ตามความ

ต้องการ   
 รองรับการเข้าถึงข้อมูลจากหลายฐานข้อมูล และ สามารถน าข้อมูลจากฐานข้อมูลในองค์กร

นั้นมาใช้งาน เช่น Excel, Access, Firebird 2.0, IBM DB2, MS SQL Server, Microsoft 
Power pivot เป็นต้น 

 รูปแบบการน าเสนอรายงานที่สวยงาม เข้าใจง่าย และง่ายในการน าเสนอต่อผู้บริหาร 
 การเข้าถึงหรือการใช้งาน สามารถท าได้โดยง่าย ตั้งแต่ผู้บริหารระดับสูง ถึง พนักงานระดับ

ปฏิบัติการ ทั้งนี้ทั้งนั้น สามารถเพ่ิมทักษะและแนวคิดให้กับพนักงานระดับปฏิบัติการ ให้มี
แนวคดิเชิงสถิติและการประยุกต์ใช้งานมากขึ้น 
 

สิ่งที่ส าคัญ คือ Engine ของ Tableau Software นั้น พัฒนาจาก VizQL Technology เป็นเทคโนโลยี
ที่ช่วยให้เห็นภาพของข้อมูลขนาดใดก็ได้เพียงการลากและวาง (Drag and Drop) โดยใช้ข้อมูลจากฐานข้อมูล 
ตอบสนองในรูปแบบของ กราฟฟิก ไม่ว่าท่านจะเป็นผู้บริหารระดับสูง (Top Management) นักวางแผนกล
ยุทธ์ (Strategic Planning) นักขายมืออาชีพ (Sales Manager) และผู้ที่อยู่ในกลุ่มธุรกิจอุตสาหกรรม, กลุ่ม
ธุรกิจน าเข้าและส่งออก, หน่วยงานรัฐวิสาหกิจ หรือ องค์ภาครัฐ รวมถึง สถานบันการศึกษาก็สามารถใช้
ซอฟต์แวร์ Tableau 

 
ผลิตภณัฑข์อง Tableau 
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Tableau Public เป็นเวอร์ชั่นที่เปิดให้ใช้งานได้โดยไม่มีค่าใช้จ่าย ดังนั้นคุณสมบัติหลายอย่างจะถูก
ลดทอนลงไป เช่นประเภทของแหล่งข้อมูล หรือข้อมูลที่จะน ามาใช้ในโปรแกรมจะถูกจ ากัดลง และจะมี
ข้อจ ากัดในเรื่องบันทึกไฟล์ที่สร้างขึ้นจากโปรแกรม คือ ไม่สามารถที่จะบันทึกไฟล์ไว้ในเครื่องที่ใช้งานได้ แต่
สามารถที่จะบันทึกไฟล์งานไว้ที่ Tableau Public Server ได ้

Tableau Desktop เป็นเวอร์ชั่นที่ต้องช าระเงินในการการใช้งาน แต่สามารถที่จะทดลองใช้งานได้ 
(Free Trial 14 days) ซึ่งคุณสมบัติต่าง ๆ ของโปรแกรมจะสามรถใช้งานได้เกือบครบทุกฟังก์ชัน(ในกรณีที่ทด
ลงใช้งาน) และสามารถน าแหล่งข้อมูลมาใช้กับโปรแกรมได้อย่างหลากหลายและครอบคลุมในการใช้งาน 
สามารถที่ จะบันทึกข้อมูลต่ าง  ๆ ไว้ภายในเครื่ องที่ ใช้ งาน หรือ สามรถ publish ไว้ ใน Tableau 
Server,Tableau Public Server หรือ Tableau Online และสามารถให้บุคคลอ่ืน ๆ สามารถเปิดดูได้ผ่าน 
Tableau Reader ได ้

 
Tableau Public Server เป็นเวอร์ชั่นที่ทาง Tableau จัดเตรียมไว้ส าหรับแสดงข้อมูลที่ได้จากการ 

publish จากโปรแกรม Tableau Public เพ่ือให้ผู้ใช้งานคนอ่ืนสามารถเข้ามาชมข้อมูลใน Workbooks ที่อัพ
โหลดขึ้นมา โดยใช้งานผ่านทาง web browser 

  
Tableau Server[1] เป็นเครื่องมือที่ใช้ส าหรับจัดเก็บแหละจัดการกับ workbooks และ data 

source ต่างๆ ที่ผู้ ใช้ งานสร้างขึ้นจากโปรแกรม Tableau Desktop โดยใช้งานผ่าน web browser 
เช่นเดียวกับ Tableau Public Server นอกจากนี้ยังสามารถจัดการกับผู้ใช้งาน จัดการ site และตั้งค่าต่าง ๆ 
ของระบบได้เอง โดยจะต้องน ามาติดตั้งในเครื่อง Server ของหน่วยงานนั้น ๆ เอง และมีการคิดค่าใบอนุญาต
(license) 

แหล่งที่มา : Jones, B.(2014). Communicating Data with Tableau(1 edition). Sebastopol, CA:O’Reilly Media. 



 
6 

 คุณติดตั้งซอฟต์แวร์และดูแลรักษาระบบด้วยฮาร์ดแวร์ของคุณเองภายในหรือภายนอกไฟร์
วอลล์ของ บริษัท 

 คุณสามารถสร้างและดูแลไซต์ได้หลายแห่งโดยไม่มีค่าใช้จ่ายเพ่ิม และสามารถก าหนดสิทธิ์
ผู้ใช้งานได้ 

 คุณสามารถก าหนดเวลารีเฟรชการเผยแพร่ได้ สามารถก าหนดไว้ล่วงหน้าหรือสร้าง
schedule ทีคุ่ณก าหนดเองได ้

 สามารถก าหนดค่าส าหรับการตรวจสอบสิทธิ์แบบ local ,Active Directory integration, 
trusted authentication หรือการลงชื่อเพียงครั้งเดียวโดยใช้ SAML หรือ Kerberos 

 จัดเตรียม Core Licensing option ซึ่งอนุญาตให้ Guest เข้าถึงได้ 
 รองรับการเชื่อมต่อแบบ live กับแหล่งข้อมูลภายในของคุณรวมถึง Google BigQuery และ 

Amazon Redshift 
 สามารถอัปโหลดโลโก้ บริษัท ของคุณ 

 
Tableau Online[2] เป็นเครื่องมือที่ใช้ส าหรับจัดเก็บแหละจัดการกับ workbooks และ data 

source ต่างๆ ที่ผู้ใช้งานสร้างขึ้นจากโปรแกรม Tableau Desktop เช่นเดียวกับ Tableau Server เพียงแต่
ผู้ใช้งานไม่ต้องจัดเตรียมเครื่อง Server และบ ารุงรักษาระบบเอง โดยทีมงานของ tableau จะด าเนนิการให ้

 ฮาร์ดแวร์และระบบที่บ ารุงรักษาโดย Tableau 
 คุณสามารถซื้อและดูแลไซต์ได้หลายแห่ง และสามารถก าหนดสิทธิ์ผู้ใช้ได ้
 สนับสนุนการเชื่อมต่อข้อมูลแบบ live กับ Amazon Redshift, Google BigQuery บน

พ้ืนฐานด้วย SQL จากโฮสต์บนแพลตฟอร์มระบบคลาวด์  
 สามารถก าหนดเวลารีเฟรชข้อมูลที่เผยแพร่ 
 ตรวจสอบผู้ใช้ผ่าน TableauID (ที่อยู่อีเมลและรหัสผ่าน) หรือก าหนดค่าไซต์ส าหรับการลง

ชื่อเพียงครั้งเดียวโดยใช้ SAML 
 ไม่มี Guest user ผู้ใช้ทุกคนที่เข้าถึง Views และแดชบอร์ดที่เผยแพร่บน Tableau Online 

ต้องได้รับการตรวจสอบสิทธิ์ 
 สามารถอัปโหลดโลโก้ บริษัท ของคุณ 

 
Tableau Reader เป็นเครื่องเมือที่ใช้แสดงผล จาก workbooks ที่สร้างจาก tableau desktop 

 
 
 
 
 
 
 
 
 

แหล่งที่มา : [1],[2] https://community.tableau.com/docs/DOC-10262 
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ตารางแสดงคุณสมบัติของ Tableau แต่ละประเภท 
Product Data Source Share Remark 
Tableau Public File 

   Microsoft Excel 
  Text file 
  JSON file 
  Microsoft Access 
  PDF file 
  Spatial file 
  KML file 
  ESRI Shapefiles 
  Mapinfo Tables 
  Mapinfo Interchange 
  GeoJSON 
  Statistical file 
  SAS file 
  SPSS file 
  R file 
Server 
  OData 
  Google Sheets 
  Web Data Connector 

Tableau Public 
Server 

free 

Tableau 
Desktop 

File 
   Microsoft Excel 
   Text file 
   JSON file 
   Microsoft Access 
   PDF file 
   Spatial file 
   KML file 
   ESRI Shapefiles 
   Mapinfo Tables 
   Mapinfo Interchange 
   GeoJSON 
   Statistical file 
   SAS file 
   SPSS file 

Tableau Public 
Server 
Tableau Reader 
Tableau Server 
Tableau Online 

Free trial 14 
days 
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Product Data Source Share Remark 
    R file 

   Other 
 Tableau Workbook 
 Tableau Package Workbook 
 Tableau Data Source 
 Tableau Package Data Source 
 Tableau Data Extracts 
 Microsoft Access Database 
 Excel Workbooks 
 Local Cube Files 
 Character Delimiter Files 
 Text Files 
 .pdf 
 Statistical Files 
 Tab Delimiter File 
 Spatial File(other) 

Server 
   Tableau Server 
   MySQL 
   Oracle 
   Amazon Redshift 
   HP Vertica 
   PostgreSQL 
   Microsoft SQL Server 
   Other 

  

Tableau Public 
Server 

Workbooks from Tableau public 
Workbooks from Tableau Desktop 

-  

Tableau Server Workbooks from Tableau Desktop -  
Tableau Online Workbooks from Tableau Desktop -  
Tableau 
Reader 

Workbooks from Tableau Desktop -  
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บทท่ี 2 ดำวน์โหลดและติดตั้งโปรแกรม Tableau Desktop  
(version 10.4 ทดลองใช้ฟรี 14 วัน) 

กำรดำวนโ์หลด 

เข้าไปดาวน์โหลดโปรแกรมได้ที่เว็บไซต์ของ Tableau 
https://www.tableau.com/support/releases/desktop/10.4 

 

 
 
  จากนั้นคลิกท่ีปุ่ม TRY IT FOR FREE เพ่ือท าการดาวน์โหลดโปรแกรม 

 

https://www.tableau.com/support/releases/desktop/10.4
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โปรแกรมจะแสดงหน้าต่างให้ท าการบันทึก โดยเลือก Directory ที่ต้องการแล้วกดปุ่ม Save 

 
 
 
ขั้นตอนกำรติดตั้ง Tableau 

 
เมื่อท าการดาวน์โหลดมาแล้วให้ท าการ Double Click ที่ไอคอนของโปรแกรมเพ่ือท าการติดตั้ง 
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เมื่อท าการติดตั้งแล้ว โปรแกรมจะขึ้นหน้าต่างให้เรากรอกข้อมูลเพ่ือลงทะเบียนใช้งานโปรแกรม เมื่อ
เรากรอกข้อมูลเรียบร้อยแล้วให้ click ที่ Start trail now 

 
 

จะได้หน้าต่างโปรแกรมดังภาพ 
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บทท่ี 3 เรียนรู้และใชง้ำน 
 
 

เมื่อเปิดโปรแกรม Tableau Desktop ขึ้นมา จะปรากฏหน้าต่างของโปรแกรมดังรูปด้านล่าง 

 
 

1. หน้าต่างส าหรับการเชื่อมต่อกับแหล่งข้อมูลที่จะน ามาใช้ส าหรับ workbooks ซึ่งสามารถเปิดจากไฟล์
ประเภทต่างๆ หรือเชื่อมกับ Relational Database , Cloud Service หรือประเภทอ่ืนๆ 

2. แสดง workbooks ที่เราเคยสร้างไว้แล้วในเครื่องหรือเปิดครั้งล่าสุด 
3. ตัวอย่าง workbooks 
4. แหล่งข้อมูลส าหรับศึกษาเพ่ิมเติม 
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กำรเช่ือมต่อกบั data source 

 Tableau นั้นสามารถท าการเชื่อมต่อกับ data source ได้หลากหลาย ทั้งแบบจากไฟล์ หรือมีการ
เชื่อมต่อไปยัง Server ซึ่งอาจมีวิธีและรายละเอียดปลีกย่อยที่แตกต่างกันไป ตัวอย่างต่อไปนี้จะแสดงการ
เชื่อมต่อโดยใช้ไฟล์ excel ซึ่งมีข้ันตอนและวิธีการดังนี้ 
 

เลือกไฟล์ข้อมูลที่ต้องการน ามาวิเคราะห์หรือใช้งาน โดยในตัวอย่างจะเลือกประเภทไฟล์แบบ excel 

 
 

จะปรากฏหน้าต่างดังรูป ซึ่งจะประกอบไปด้วยเครื่องมือต่างๆ ดังรายละเอียดด้านล่าง โดย Tableau 
จะมอง data source เหมือนตาราง(table) ซึ่งในหน้านี้เราสมารถที่จะท าการเชื่อมโยง (Join) data source 
โดยใช้ Key ต่างๆ ที่มีการเชื่อมโยงกันได้เช่นเดียวกับ relational database 
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1. ส่วนที่แสดงให้เห็นว่า ณ ปัจจุบันที่ใช้งานอยู่ เชื่อมต่อกับอะไรบ้าง สามารถเพ่ิมการเชื่อมต่อกับไฟล์
หรือ server โดยคลิกที่ add 

2. แสดงรายละเอียดของ connection ด้านบนว่าข้อมูลภายในมีอะไรบ้าง โดยจะเปลี่ยนตามการคลิกที่ 
connection ด้านบน 

3. ชื่อ Data Source ที่เชื่อมต่ออยู่ 
4. ชื่อ Table 
5. ประเภทการเชื่อมต่อ live, Extract 
6. ตัวกรองข้อมูล 
7. ข้อมูลภายใน Table 

 
สร้ำง Workbook ใหม่ 

 เมื่อเราเปิดโปรแกรมขึ้นมา เราจะต้องท าการสร้าง Workbook เพ่ือเก็บชิ้นงานของเรา ซึ่งใน 
Workbook จะประกอบไปด้ ว ย  Worksheet, Dashboard, Story ร วมทั้ ง  data source ที่ ใ ช้ ง าน ใน 
Workbook ซึ่งจะอธิบายในล าดับต่อไป 

 
 
 คลิกท่ีเมนู File > New ที่ Menu bar 
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 จะได้ Workbook ใหม่ข้ึนมา และมีส่วนประกอบดังรายละเอียดด้านล่างนี้ 

 
 
ส่วนประกอบ User interface ของโปรแกรม 

1. Menu and Toolbar จะแสดงรายการเมนูต่าง ๆ ของโปรแกรม 
2. Data Pane เป็นส่วนที่ใช้ส าหรับแสดงข้อมูลของใน Data Source ที่ใช้งานใน Workbook  
3. Analytics Tab เป็นส่วนที่ใช้แสดงรายการเมนูที่เก่ียวข้องกับการวิเคราะห์ข้อมูล 
4. Marks Card เป็นเมนูที่เกี่ยวข้องกับการปรับเปลี่ยนลักษณะการแสดงผลของ graph ,chart ,map 

เช่น สี ข้อความ tooltip ประเภทของกราฟ เป็นต้น 
5. Data Preview เป็นส่วนส าหรับแสดงผลข้อมูล 
6. Sheet Tab เป็นกลุ่มของเมนูที่เก่ียวข้องกับการสร้าง worksheet, dashboard, story  

a. Worksheet คือ view ส าหรับแสดงผลของ graph ,chart ,map ฯ ซึ่งใน 1 worksheet จะ
มีเพียงหนึ่งประเภท 

b. Dashboard คือส่วนที่ใช้ส าหรับน า Worksheet หลายๆ Worksheet มาแสดงผลในหน้า
เดียวกัน อาจเป็นลักษณะของภาพรวมด้านต่าง ๆ  

c. Story คือการน าเอา Worksheet และ Dashboard มาเรียงต่อกันเป็นหน้า ซึ่งแต่ละหน้าจะ
มีเพียงหนึ่ง Worksheet หรือ Dashboard โดยมีลักษณะเป็น tab ให้คลิกเลือกในแต่ละหน้า 

7. กลุ่มเมนูส าหรับปรับเปลี่ยนการแสดงผล worksheet , dashboard , story ที่มีใน workbook 
เพ่ือให้ง่ายต่อการใช้งาน 

8. Workspace Controls เป็นส่วนส าหรับปรับเปลี่ยนหรือแสดงประเภทของ graph, chart, map ที่
สามารถใช้งานกับข้อมูลแต่ละประเภท โดยโปรแกรมจะแนะน าให้เองอัตโนมัติ เมื่อเราคลิกที่ข้อมูล
จาก Data Pane 
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เริ่มต้นใช้งาน 
 

เพ่ิมแหล่งข้อมูล (Data Source) ที่จะใช้งานใน Workbook โดยคลิกที่ปุ่ม Data Source 

 
 

เลือกการเชื่อมต่อกับแหล่งข้อมูลที่ต้องการ ในตัวอย่างนี้จะใช้ข้อมูลตัวอย่างที่มีในโปรแกรมอยู่แล้ว 

 
 

จะเห็นว่าในส่วนของ Data Pane ได้มีการเปลี่ยนแปลงโดยแสดงข้อมูลที่มีอยู่ใน Data Source นั้น 
ซึ่งหลักๆ แล้วแบ่งออกเป็น 2 ประเภท คือ 

o Dimensions คือสิ่งที่ใช้อธิบายความหมายในแต่ละ แง่มุม โดยส่วนใหญ่แล้วข้อมูลที่เก็บอยู่
ข้างในมักจะไม่มีการเปลี่ยนแปลง เช่น ข้อมูลที่ไม่เกี่ยวข้องกับการค านวน แต่สามารถใช้เพ่ือ
อธิบาย หรือแจกแจงประเภทของข้อมูล 

o Measures คือความจริงที่เกิดขึ้นในระบบ ข้อมูลที่เก็บอาจจะเป็นการ summary ของอะไร
บางอย่าง และเก็บ key ต่างๆไว้เ พ่ือ link ไปยัง dimension  ซึ่ง Measure อาจต้อง
เปลี่ยนแปลงอยู่เรื่อยๆ เช่น ข้อมูลที่มีลักษณะของตัวเลขที่แสดงเชิงปริมาณ สามารถน ามา
ค านวนวิเคราะห์ได้ 
 

ซึ่ง Dimension หรือ Measures นั้นโปรแกรมจะแบ่งให้อัตโนมัติ เราสามารถย้ายหรือปรับเปลี่ยน
ประเภทเองได ้และยังสามารถปรับเปลี่ยนประเภทของข้อมูล(Datatype) เองได้ 
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Datatype ของข้อมูล มีดังนี้ 
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กำรสร้ำง Worksheet 

 เมื่อเราเปิดโปรแกรม และมีการสร้าง workbook ใหม่ข้ึนมา โปรแกรมจะสร้าง worksheet หน้าแรก
ให้อัตโนมัต ิหรือหากต้องการสร้างเองให้คลิกท่ีปุ่ม new worksheet 

  
 

ทดลองสร้างกราฟ โดยท าการลาก Sales(ยอดขาย) จาก Measures มาวางไว้ในส่วน Columns แล้ว
ลาก Category(หมวดหมู่ของสินค้า) จาก Dimensions มาวางที่ Rows 
 จะเห็นว่าโปรแกรมได้แสดงกราฟ ตามเงื่อนไขที่เราได้ระบุลงใน Rows และ Columns คือในแนว 
Columns(แนวตั้ง) จะแสดง Category(หมวดหมู่ของสินค้า) แต่ละประเภท ส่วนแนว Rows(แนวนอน) จะ
แสดงผลรวมของยอดขายสิ้นค้า(sum(sales)) 
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เมื่อเราลาก Sub-Category(หมวดหมู่ย่อยของสินค้า) มาวางใน Columns ก็จะได้กราฟที่แสดง
หมวดหมู่ย่อยของสินค้าภายใต้หมวดหมู่สินค้าหลัก(Catagory) 

 
 

เรายังสามารถเพ่ิมสีให้กับกราฟ โดยท าการลาก Sales มาวางที่ Color ใน Marks Card เพ่ือให้กราฟ
สื่อความหมายได้ดีขึ้น เช่นสีแดงเป็นสินค้าท่ียอดขายไม่ดี จ าเป็นต้องแร่งแก้ไข ส่วนสีเขียวเป็นสินค้าท่ีขายดี 

 
 

นอกจากนี้เรายังสามารถปรับเปลี่ยนประเภทของ graph , chart ได้ ชึ่งแต่ละประเภทก็จะสามารถสื่อ
ความหมายได้หลากหลายมิติ แตกต่างกันไป ดังนั้นเราจึงต้องเลือกใช้ให้เหมาะสมกับงานของเราว่าต้องการจะ
สื่ออะไร  
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กราฟที่ 1 (Worksheet 1) 

 
 จากตัวอย่างกราฟข้างต้นนี้ เราจะได้กราฟ แสดงผลรวมของยอดขาย ของสินค้า ในแต่ละหมวดหมู่
ย่อยของสินค้า โดยใช้สีเพ่ือสื่อความหมายถึงยอดขายสินค้า คือถ้าอยู่ในโทนสีแดงแสดงว่ายอดขายสินค้าอาจ
ก าลังมีปัญหา และถ้าอยู่ในโทนสีเขียวแสดงว่ายอดขายสินค้านั้นขายดี ซึ่งจากกราฟนี้ก็จะช่วยให้บริษัท
สามารถตัดสินใจเกี่ยวกับสินค้านั้น ๆ ได้ดียิ่งข้ึน 
  
 จากตัวอย่างนี้เราจะได้กราฟ 1 กราฟอยู่ใน Worksheet จากนั้นให้เปลี่ยนชื่อ Worksheet เพ่ือให้สื่อ
ความหมาย ในตัวอย่างใช้ชื่อ Sum Sales 
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สร้าง Worksheet ใหม่ตั้งชื่อว่า Sum Profit ปรับเปลี่ยนกราฟเพ่ือให้สื่อความหมายตามต้องการ โดย
ในตัวอย่างนี้มีการใช้สี และขนาดของกราฟ เพ่ืออธิบายให้มีความชัดเจนยิ่งขึ้น คือถ้ากราฟที่สีอยู่ในโทนเขียว 
ขนาดใหญ่ แสดงว่าสินค้าประเภทนั้นมีผลรวมของก าไร(Profit) มาก และถ้าอยู่ในโทนสีแดง ขนาดเล็ก แสดง
ว่าประเภทสินค้านั้นมีผลก าไรหรือขาดทุน 

 

 
กราฟที่ 2 (Worksheet 2) 

 
สร้าง Worksheet ใหม่ตั้งชื่อว่า country เพ่ือแสดงประเทศที่ส่งสินค้าไปขาย โดยแบ่งสีให้แต่ละ

ประเทศเพ่ือให้ดูง่าย และเพ่ิม label เพ่ือให้แสดงชื่อประเทศ 

 
แผนที่ 1 (Worksheet 3) 
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สร้าง Worksheet ใหม่ตั้งชื่อว่า Quantity By Country ขั้นตอนในการสร้างเช่นเดียวกับ Worksheet 
ที่ 1 และ 2 แต ่

 
กราฟที่ 4 (Worksheet 4) 

 
 
 

กำรสร้ำง Dashboard   

คลิกท่ีปุ่ม new dashboard ที่ Sheet tab ด้านล่าง 

 
 

ในตัวอย่างนี้ ตั้งชื่อว่า Product Quantity By Country  ซึ่งใน Dashboard นี้จะเป็นการแสดง
ข้อมูลแผนที่ของประเทศจาก Worksheet ที่ 3 และเม่ือคลิกท่ีแผนที่ของแต่ละประเทศ จะให้แสดงจ านวน
สินค้าแต่ละประเทศท่ีขายได้ จาก Worksheet ที่ 4 
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จากนั้นท าการลาก Worksheet มาวางตาม Layout ดังภาพ 

 
 

เพ่ิม Action ให้กับ Dashboard โดยคลิกที่เมนู Dashboard > Actions 
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จากนั้นเลือกท่ี Add Action> แล้วเลือก Filter… 

 
 

จากนั้นตั้ งชื่อ filter แล้วเลือก Source คือ Country ใน Dashboard “Product Quantity By 
Country” แล้วเลือก target คือ Quantity by country ใน Dashboard “Product Quantity By Country” 
เช่นเดียวกัน โดยก าหนดให้ท างานก็ต่อเมื่อมีการ Select  
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กำรสร้ำง Story 

คลิกท่ีปุ่ม new story ที่ Sheet tab ด้านล่าง 

 
 

จากนั้นตั้งชื่อว่า Product Story 

 
 

ลาก Worksheet และ Dashboard มาวาง โดยชิ้นแรกให้วางในพ้ืนที่สีส้ม(1) ชิ้นที่สองเป็นต้นไปให้
น ามาวางต่อบริเวณ tab ที่อยู่ด้านบน(2) เมื่อวางเสร็จแล้วให้ตั้งชื่อ tab ให้สื่อความหมาย 
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ตวัอยำ่งเพ่ิมเติม 

 
การใช้งานแผนที่ประเทศไทย 
 

 
เลือกประเภทการ connect เป็น To a File 
จากนั้นเลือก more  แล้วเลือกไฟล์ .shp แล้วกด open 
 

 
จากนั้นสร้าง sheet ขึ้นมา 
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โปรแกรมจะเปลี่ยนมาที่หน้าต่างดังรูป 
จากนั้นท าการเปลี่ยนประเภท data type ของ Prov Name E ให้เป็นประเภท Geographic โดยคลิ๊กขวา 
แล้วเลือก Geographic Rile > State/Province 
 
 

 
จากนั้นท าการลาก Prov_Nam_E มาวางที ่sheet 
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เปลี่ยนประเภทของกราฟให้เป็น Map 
 

 
จะเห็นว่ามีบางจังหวัดที่ tableau ยังไม่สามารถระบุต าแหน่งได้ เนื่องจากชื่ออาจจะยังไม่ตรงกับที่มีในแผนที่ 
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แก้ไขโดยไปที่เมนู Map > Edit Locations.. 
 

 
จะเห็นว่ามีจังหวัดที่ไม่สามารถระบุได้ ให้คลิกท่ี Unrecignized 
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ให้พิมพ์ชื่อจังหวัดที่ถูกต้อง ถ้ามี โปรแกรมจะแสดงชื่อจังหวัดนั้นให้เลือก 
 

 
เมื่อแก้ไขครบแล้วให้คลิ๊กท่ี OK 
จะเห็นว่าแผนที่มีจังหวัดครบแล้ว 
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จากนั้นให้ลาก Prov_Nam_E มาวางที่ Color ใน Mask เพ่ือแบ่งจังหวัดแต่ละจังหวัดให้เป็นสี เพ่ือความ
สวยงามและง่ายในการมอง 
 

 
ลาก Prov_Nam_T และ Prov_Nam_E มาวางที่ Detail ใน Mask เพ่ือให้แสดงรายละเอียดของชื่อจังหวัด
เมื่อมีการน าเมาส์มางวางที่เหนือรูปจังหวัด 
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จากนั้นให้เปลี่ยนชื่อ sheet เป็น country 
 

 
แล้วสร้าง sheet ขึ้นมาอีก 1 หน้าแล้วตั้งชื่อว่า province 
 
 

 
ลาก Geometry จาก Measure มาวางใน sheet  



 
33 

 
ลาก Prov_Nam_E มาวางในช่องของ Filters เพ่ือกรองข้อมูลให้แสดงเพียงจังหวัดเดียว 
 
 

 
ปรับแต่งรายละเอียดที่จะแสดงใน tooltip ตามต้องการโดยเลือก field ที่ต้องการแล้วลากมาวางในส่วนของ 
masks  
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สร้าง dashboard ขึ้นมาเพ่ือจัดวาง sheet ต่างๆ เพื่อแสดงให้ User ได้ด ู
 

 
ลาก sheet country และ province มาวางแล้วปรับแต่งให้สวยงาม 
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ท าการสร้าง Action ให้กับ Dashboard คือเมื่อ User ท าการ click ที่รูปจังหวัดใน sheet country แล้วให้
ท าการ filter ให้แสดงเฉพาะรายละเอียดของจังหวัดนั้น ใน sheet province 
โดยไปท่ี Dashboard > Actions > Add Action เลือก Filter 
 

 
ในส่วนของ Source sheet เลือก country 
Target sheet เลือก province  
เมื่อลองคลิกดูจะเห็นว่าแผนที่มีการเชื่อมและแสดงผลสัมพันธ์กันแล้ว 
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เมื่อเสร็จแล้วให้บันทึกไฟล์ workbook ไว้ในเครื่อง หรือ สามารถ publish ขึ้น tableau server ได้ เพ่ือให้ผุ้
ใช้งานคนอื่นสามารถเข้ามาชมได้ผ่านเว็บ 
 
กำรบนัทึกไฟลล์งเกบ็ในเคร่ืองผูใ้ชง้ำนเอง 

 การบันทึกไฟล์งานของ Tableau คลิกท่ี File > Save หรือ Save As… จากนั้น ตั้งชื่อไฟล์ที่ต้องการ และ
ประเภทของไฟล์ เลือก .twbx เพ่ือจัดกับทุกอย่างที่เก่ียวกับ Workbook รวมทั้ง Data Source แต่ถ้าไม่ต้องการ Data 

Source ด้วย สามารถเลือกเป็น .twb 
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กำร Publish workbook ข้ึน tableau Server 

 

 
ไปที่เมนู Server > Publish Workbook 
 
 

 
ใส่หมายเลขไอพีของ Tableau Server 
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ใส่ username และ password ในการลงชื่อเข้าใช้งาน tableau server 
 

 
เลือก project เป็น training2018  จากนั้นตั้งชื่อ และใส่รายละเอียดของ workbook แล้วกดท่ีปุ่ม publish 
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ถ้า workbook ของเรามีการเรียกใช้งานขอมูลจากแหล่งอ่ืนด้วยและไฟล์มีขนาดใหญ่ โปรแกรมจะถามว่า
ต้องการด าเนินการต่อหรือไม่ ตอบ Yes 
 

 
โปรแกรมจะท าการอัพโหลดไฟล์ต่างๆ ที่เก่ียวข้องขึ้นไปที่ tableau server 
 

 
เมื่อเสร็จแล้วโปรแกรมจะเปิดหน้าเว็บของ tableau server สามารถคลิ๊กเพ่ือรับชมได้ 
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กำร Publish Data Source ข้ึน Tableau Server 

 คลิกเมนู  Server > Publish Data Source > ชื่อ Data Source 

 
 
 ใส่ URL ของเครื่อง Server 

 
 
 ท าการเข้าสู่ระบบ Tableau Server 
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 เลือก Project เป็น tarining2018 ส่วนชื่อ โปรแกรมจะระบุให้อัตโนมัติ สามารถเปลี่ยนได้ จากนั้นท า
การก าหนด Permissions โดยคลิกที่ Edit > Custom แล้วเลือกว่าจะให้สามารถมีสิทธิ์อะไรบ้าง เมื่อก าหนด
แล้วคลิก OK 
 

 
 
 เมื่อส าเร็จแล้วปรแกรมจะขึ้น Dialog ดังรูป 
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เพิ่มเติม 
กำรเช่ือมต่อ Vertica 

ดาวน์โหลด driver ตามลิงค์ด้านล่างนี้ 
https://my.vertica.com/download/vertica/client-drivers/ 
แล้วท าการติดตั้ง 

 
 

 

https://my.vertica.com/download/vertica/client-drivers/
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กำรเช่ือมต่อ Hadoop 

 

 

 
 
 
 


